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Web Site:
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#$KAbout ModelMagic3D

ModelMagic 3D, version 1.40, is an easy to use, interactive, 3D modeling package used to create OpenGL scenes rendered in real-time. Build 2D and 3D objects from pre-defined primitives, add text, lighting and animation.  Features include texture mapping of BMP (bitmap) images or play AVI movies as textures mapped to any 3D surface. Print your work or save it in native WLD format or as a standard Windows bitmap.  The demo version is full featured, allowing you to create, modify and save your work.  The full version includes additional texture maps, 3D scenes, 3D objects, FREE upgrades to new releases and FREE technical support via. email.

Company Statement:

Our goal is to supply quality 3D Modeling and animation software at affordable prices, while at the same time, supply the developing community accesses to the underlying code. We believe in the Open Source code model. (How many times have you wished you had the code to your favorite program so that you could 'see' how they accomplished some feature, or wished that you could add your own feature?)

See a feature missing?  Want us to add new features?  E-mail us at mailto:support@imagewaredev.com 

We will incorporate your suggestions into our next release, if possible.  

#$KAbout 'glOOP' - OpenGL Object Oriented Programming API Library

Documentation forthcoming.  

#$KRegistering

You can order from ImageWare Development by payment with check or credit card (MasterCard and Visa). The numbers for ordering are:  Voice (615) 366-6357 or place your order on our secured web server at http://www.imagewaredev.com

NAME _______________________________________________________________________________

COMPANY __________________________________________________________________________

STREET _____________________________________________________________________________

STREET _____________________________________________________________________________

CITY ________________________________________________________________________________

STATE/ZIP __________________________________________________________________________

COUNTRY ____________________________
TELEPHONE ______________________________

CREDIT CARD TYPE ____________________________
EXPIRATION DATE ________________

CREDIT CARD NUMBER ______________________________________________________________

SIGNATURE _________________________________________________________________________

Product:


Disk Size
Cost:

# of Copies:
Product Total:

ModelMagic3D


3.5"

$39.95

______

$ _________

*ModelMagic3D Screen Saver
3.5"

$  0.00

______

$ _________

ModelMagic3D


CD-ROM
$39.95

______

$ _________

*ModelMagic3D Screen Saver
CD-ROM
$  0.00

______

$ _________

Tennessee residents add 8.5% sales tax




$ _________

Shipping/Handling - US or Canada

$ 5.00 ea.
______

$ _________

Shipping/Handling - Outside of US or Canada

$16.00 ea.
______

$ _________

Total in US Funds drawn on a US Bank





$ _________

* Included at NO COST when purchased with ModelMagic3D

Make checks payable to:
ImageWare Development

Mail to:



ImageWare Development

PO Box 290606

Nashville, TN  37229-0606  USA

#$KLicense Agreement

ModelMagic3D with "glOOP"(R) version 1.4

Copyright (C) 1997-1999 Craig Fahrnbach, ImageWare Development.

All Rights Reserved

You should carefully read the following terms and conditions before using this software.  Unless you have a different license agreement signed by ImageWare Development, your use of this software indicates your acceptance of this license agreement and warranty.

Registered Version

One registered copy of ModelMagic3D may either be used by a single person who uses the software personally on one or more computers, or installed on a single workstation used nonsimultaneously by multiple people, but not both.

You may access the registered version of ModelMagic3D through a network, provided that you have obtained individual licenses for the software covering all workstations that will access the software through the network.  For instance, if 8 different workstations will access ModelMagic3D on the network, each workstation must have its own ModelMagic3D license, regardless of whether they use ModelMagic3D at different times or concurrently.

Governing Law

The laws of the State of Tennessee shall govern this agreement.

Disclaimer of Warranty

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS TO PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED.  Because of the various hardware and software environments into which ModelMagic3D may be put, NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data before relying on it. The user must assume the entire risk of using the program.  ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.

#$KToolbars - General

Toolbars provide a graphical interface for model creation and editing.  All toolbars, with the exception of the TreeView, will pop-up a brief description of the icon if you move the mouse over the icon. ModelMagic3D incorporates the following toolbars: 

1.
ToolbarIDH_toolbar macrobutton NextField  macrobutton DoJump2 <+>


 macrobutton NextField 

 macrobutton NextField  macrobutton NextField 
 - Contains the standard Windows toolbar functions along with a few of the most frequent commands.

2.
TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>


 macrobutton NextField  ADDIN 



 macrobutton NextField 

 macrobutton NextField 
 macrobutton NextField 
 - Contains a graphical representation of the hierarchy of the 3D model.

3.
Color PaletteIDH_toolbar_color_palette macrobutton NextField  macrobutton DoJump2 <+>


 macrobutton NextField 

 macrobutton NextField  macrobutton NextField 
 - A rotatable color cube for selecting the current color

4.
Coordinates ToolbarIDH_toolbar_coordinates macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  - Displays the currently selected Object or point attributes.

5.
Scene ObjectsIDH_toolbar_scene_objects macrobutton NextField  macrobutton DoJump2 <+>


 macrobutton NextField 

 macrobutton NextField  macrobutton NextField 
 - Contains icons for creating scene objects.

6.
2D ShapesIDH_toolbar_2d_shapes macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  - Contains icons for creating 2-dimensional shapes and objects

7.
3D ShapesIDH_toolbar_3d_shapes macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  - Contains icons for creating 3-dimensional shapes and objects

8.
CommandsIDH_toolbar_commands macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  - Icons for moving, rotating, scaling, translating, painting, creating points, selecting points and moving points.

9.
SelectionsIDH_toolbar_selections macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  Icons for moving, rotating, scaling, translating, painting, creating points, selecting points and moving points.

Tip:
The toolbars are 'floating', i.e. they can be placed anywhere on the screen simply by dragging the toolbar to the desired location.  Toolbars can be 'docked', or fixed to either the top, bottom, left or right side of the main window.  When the program exits, it stores your desired location and restores it for future placement.

#$The Toolbar




{bmc toolbar.bmp} 
The toolbar is displayed across the top of the application window, below the menu bar.  The toolbar provides quick mouse access to many tools used in ModelMagic3D,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

The Toolbar floating toolbar performs the following functions:


New FileHID_FILE_NEW macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField ,  - Creates a new 3D world.


Open FileHID_FILE_OPEN macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField ,  - Opens an existing 3D world.


Save FileHID_FILE_SAVE macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField ,  - Saves the current 3D world.


CutHID_EDIT_CUT macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField ,      - Not currently implemented. 

CopyHID_EDIT_COPY macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField ,   - Not currently implemented. 

PasteHID_EDIT_PASTE macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField ,  - Not currently implemented. 

PrintHID_FILE_PRINT macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField ,  - Prints the current 3D world.


Toggle Grid,  - Toggles the grid On/Off.


Toggle Snap,  - Forces the mouse move positions to grid points.  Toggle On/Off.


Toggle Axis,   - Toggles the object axis display On/Off.


Multi-View,  - Displays Front, Side, Top and Isometric views of the selected window.


Edit CameraIDH_camera_configuration macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField ,  - Edit the Camera attributes.


Smooth Shade,  - Display the 3D world in Smooth shaded mode.


Wireframe view,  - Display the 3D world in wireframe view. 3D world.


Toggle Perspective,  - Toggle the camera perspective / orthographic view On/Off.


Isometric View,  - Camera to Isometric view.


Camera to Front,  - Move the camera view to Front (XZ axis).


Camera to Side,   - Move the camera view to Side (YZ axis)


Camera to Top,    - Move the camera view to Top (XY axis)


Pan Camera,  - Not currently implemented. 

Zoom In,     - Move the camera closer to the 3D world origin.


Zoom Out,  - Move the camera away from the 3D world origin.


Toggle Color Palette,  - Toggle the Color Palette dialog bar On/Off.


Help,    -  Provides online user help. 

About,  - Display the ModelMagic3D About dialog box. 

#$KThe TreeView




{bmc treeview.bmp} 

The TreeView provides a hierarchical tree view of all objects and shapes within the scene.

To resize the TreeView window, move it outside of the 'docking' area, grab the lower right corner and resized it to suite your configuration.

#$KThe Color Palette




{bml colorpalette.bmp}   

The Color Palette floating dialog box allow quick access to the available colors.

Color Cube


By left-clicking on the Color Palette Cube, you select the color located directly under the cross-hair cursor.  The color cube can be rotated to display varying colors.

Right Color Slider


A slider control is located on the right side of the Color Palette Cube that allows finer color gradient of the selected color.

Current Color

The current color is displayed below the color cube window

Color Drop-Down List box


Contains a list of all user define colors.  To define colors, see Defining Colors dialogIDH_defining_colors_dialog macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField .
#$KCoordinate Toolbar




{bmc coordinate toolbar.bmp} 

The Coordinate Toolbar is a floating toolbar which provides quick viewing and modification of the following object attributes:

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's translation from its origin.

#$KScene Objects




{bmc scene objects.bmp} 

The Scene Objects floating toolbar provides the following object types:


Light ObjectsIDH_light macrobutton NextField  macrobutton DoJump2 <+>


 macrobutton NextField  ADDIN 



 macrobutton NextField 
 macrobutton NextField 
  -  macrobutton NextField 

 macrobutton NextField Directional, Positional, Spot or Ambient/Background lights.


Terrain ObjectIDH_terrain macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  


Cloud ObjectIDH_cloud macrobutton NextField  macrobutton DoJump2 <+>


 macrobutton NextField  macrobutton NextField 

 macrobutton NextField 
 

#$K2D Shapes




{bmc 2d objects.bmp} 

The 2D Shapes, or Objects floating toolbar provides the following 2-dimensional object types:


DiskIDH_disk macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  


TriangleIDH_triangles macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  


PlaneIDH_plane macrobutton NextField  macrobutton DoJump2 <+>


 macrobutton NextField 

 macrobutton NextField  macrobutton NextField 
 


GridIDH_grid macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

#$K3D Shapes




{bmc 3d objects.bmp} 

The 3D Shapes, or Objects floating toolbar provides the following 3-dimensional object types:


ConeIDH_cone macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  


CylinderIDH_cylinder macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  


CSGIDH_csg__constructive_solid_geometry macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  (Constructive Solid Geometry)


CubeIDH_cube macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  


LatheIDH_lathe macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  


h-SplineIDH_nurb macrobutton NextField  macrobutton DoJump2 <+>

NURBIDH_nurb macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  (Non-Uniform Rational B-spline)


SphereIDH_sphere macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  


TorusIDH_torus macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  


True Type FontIDH_true_type_font macrobutton NextField  macrobutton DoJump2 <+>


 macrobutton NextField  macrobutton NextField 
 

#$KSelections




{bmc selection.bmp} 

The Selections floating toolbar provides the following selections:


Camera
Commands are to be applied to the Camera.


Parent Object
Commands are to be applied to the Parent Object.


Child Object
Commands are to be applied to the selected Child Object.


Object



Axis
Commands are to be applied to the selected objects Axis.


Texture
Commands are to be applied to the selected objects' Texture.


Texture Axis
Commands are to be applied to the selected objects' Texture Axis.


Edges
Commands are to be applied to the selected objects' Edges.


Object Points
Commands are to be applied to the selected objects' Points.


Points
Commands are to be applied to the selected Point.

#$KCommands




{bmc actions.bmp} 

The Commands floating toolbar provides the following mouse move functions:


Select
Select the item.


Move
Move the selected item in 3D space.


Rotate
Rotate the selected item in 3D space.


Scale
Scale the selected item.


Paint Object/Points
Paint the selected object with the Color toolbar's current color.  If Object Points are selected, the color is applied to the objects' vertice.


Create Points
Create new points.


X-Axis  Lock/Unlock
Enable/Disable mouse coordinates along the X-Axis.


Y-Axis Lock/Unlock
Enable/Disable mouse coordinates along the Y-Axis.


Z-Axis Lock/Unlock
Enable/Disable mouse coordinates along the Z-Axis.

#$KKeyFrame Animation Control




{bmc keyframe toolbar.bmp} 
KeyFrame animation is a method of Object animation that allows you to 'save' the objects attributes as you want them displayed at the 'time' interval you want.  You Record keyframe object data at critical time intervals.  When animation begins, the program will interpolate the objects values, i.e. position, scale, color, etc., for smooth animation between frames.

The KeyFrame floating toolbar provides the following functions:


Record.  - Record an objects attributes at the 'time' interval displayed


UnRecord Keyframe.  - Erase keyframe from the selected object keyframe list.


Play Animation Sequence.  (Currently not implemented)


First KeyFrame.  - Rewind to the first keyframe in the list.


Previous KeyFrame.  - Rewind to the previously recorded keyframe.


Next KeyFrame.  - Fast forward to the next recorded keyframe.


Last KeyFrame.  - Fast forward to the last recorded keyframe in the list.


Decrease Time.   - Decrease the time interval by one second.


Current Time Interval, in seconds.


Increase Time Interval.  - Increases the time interval by one second.

#$KWhat's New in Version 1.03:


Added this Help file (partial)


Added Print and Print Preview features


Added ability to save screen image in *.bmp format


Added *.AVI texture mapping to 3d surfaces, with audio


Added ability to apply texture maps to the background


Added material preview window to Material dialog

#$KWhat's New in Version 1.1:


Revised the toolbars and menu layout.


Added Object 'point' manipulation, to allow for more flexible shapes.


Added Triangle Shape.


Added the NURBS Shape.


Added ability to rotate and move the camera interactively.


All child object interactive manipulations are now performed in world coordinate space.

#$KWhat's New in Version 1.4:


Added Object 'point' Color attributes to achieve a color smoothing effect.


Added the Terrain object for realistic landscape features.


Added the Cloud object for realistic clouds/ground fog.

#$KBug Fixes


Eliminated the "Invalid pixel format" error when opening multiple windows


Fog is now correctly rendered

#$KCreating a 3D world 
ModelMagic3D allows you to create 3D scenes, or worlds, by the camera location, adding lights and objects.  To create a new 3D world:

1.
Select the File New menu option New commandHID_FILE_NEW macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField , 

2.
Press Control-N, or 

3.
Press the New 3D World icon in the toolbar. 


{bmc filenew.bmp}
#$KCreating Colors

You can create pre-defined colors for later use by using the Edit ColorsIDH_defining_colors_dialog macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  dialog.

#$KCreating Materials

You can create pre-defined materials for later use by using the Edit MaterialsIDH_edit_material_attrubutes macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  dialog.  To use these pre-defined materials, double click on an existing object's name in the TreeView dialog.  The selected object's dialog box will appear.  Select the Color/MatIDH_color_mat_l macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  tab.  You can select the predefined material from the dropdown selection.

#$KConfiguring the camera




{bmc camera config.bmp}
The Camera configuration dialog allows you to set the following attributes:

Camera Definition:

Camera Lens

Select the camera view as either Perspective or Orthographic.

Clipping Fustrum

Near - Set the 'Near' clipping dimension nearest the camera where objects will be 

           clipped.

Far  - Set the 'Far' clipping dimension furthest from the camera where objects will be

         clipped.

Field of View - Set the camera viewing angle Field of View.

Left, Right, Top and Bottom  - Used for information only.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the camera's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the camera's rotation about the world origin.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the camera.

#$KLights




{bmct lights dialog.bmp} 

The Lights scene object adds a light of the specified type to the 3d scene.  Lights casts a constant amount uniformly throughout the scene.  The Ambient Light configuration dialog allows you to set the following attributes:

Light Definition:

Name

Give your light a name.  This name will be displayed in the TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 

 macrobutton NextField Light Type

Point Light        - The light is a Point light. Light will be emitted in all directions.

Spot Light         - The light is a Spot light.  The spot angle and the Directional Length

  determine the radius of the 'spot'.

 Ambient Light  - The light is an Ambient, or Background light.  Light is emitted in all

 directions.

Display As

None        - The light is NOT to be displayed.

Sphere     - Display the light as a Sphere.

Cylinder   - Display the light as a Cylinder. (Tube)

Plane       - Display the light as a Plane.

Spot Angle

The Cutoff angle defines the width of the light beam(s) emanating from the light source.  The default value is 180 degrees.  By reducing this value to can create a Spot Light effect. (Say 25 degrees)

Directional Length

This is the lights 'focal' length.  When the light is defined as a 'Directional' light, this member variable is used to determine the direction the light is 'pointed'.

'W' Component


Define the light as either Directional or Positional.

Attenuation


Applies to Positional Lights only.  Attenuation allows you to define how the intensity of the 
light is effected by the distance of the light from the rendered surface.  The default attenuation factor is Constant, with an Attenuation factor of 1.0

Light ColorIDH_light_color macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the light's color attributes.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the light's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the light's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the light's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the light's translation from its origin.

TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the light's texture.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the light.

#$KLight Color




{bmct light color dialog.bmp} 

Directional light casts parallel from the light source to the 3D scene.  The Directional Light configuration dialog allows you to set the following attributes:

Directional Light Definition:

Name

Give your light a name.  This name will be displayed in the TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 

 macrobutton NextField Ambient Color

A drop-down list box displaying the user defined ambient, or constant, color component of the light.  The color Button is used to display the selected color.  Pressing the button displays the Color AttributesIDH_color_attributes_dialog macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  dialog box for selecting colors that are not displayed in the drop-down list.

Diffuse Color

A drop-down list box displaying the user defined diffuse, or directional, color component of the light.  The intensity of diffuse light reflecting from the surface of the object will vary depending on the angle between the surface and the light source. The color Button is used to display the selected color.  Pressing the button displays the Color AttributesIDH_color_attributes_dialog macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  dialog box for selecting colors that are not displayed in the drop-down list.

Specular Color

A drop-down list box displaying the user defined specular, or reflected, color component of the light.  The intensity of specular light reflecting from the surface of the object will vary depending on the angle between the surface and the light source and the reflective property of the surface's material. The color Button is used to display the selected color.  Pressing the button displays the Color AttributesIDH_color_attributes_dialog macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  dialog box for selecting colors that are not displayed in the drop-down list.

Specular Highlight

Specular power allows you to define how specular highlights from surfaces are rendered.  The higher the specular power, the sharper the highlight.

Light DefinitionIDH_light macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField   macrobutton NextField  

Dialog tab for setting the light's attributes.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the light's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the light's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the light's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the light's translation from its origin.

TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the light's texture.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the light.

#$KTriangles




{bmc triangle config.bmp} 
The Triangle is a flat, three-sided surface, defined by Width and Height.

Triangle Definition:

Name

Give your shape a name.  This name will be displayed in the TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 

 macrobutton NextField Width

The width, in the X-axis, of the triangle.

Height

The height, in the Y-axis, of the triangle.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's translation from its origin.

Color / MaterialIDH_color_mat_l macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 
D macrobutton NextField ialog tab for setting the object's color and material.

TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's texture.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the object.
#$KPlane




{bmc plane config.bmp}
The Plane is a flat, four-sided surface, defined by Width and Height.

Plane Definition:

Name

Give your shape a name.  This name will be displayed in the TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 

 macrobutton NextField Width

The width, in the X-axis, of the plane.

Height

The height, in the Y-axis, of the plane.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's translation from its origin.

Color / MaterialIDH_color_mat_l macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 
D macrobutton NextField ialog tab for setting the object's color and material.

TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's texture.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the object.

#$KCube




{bmc cube config.bmp} 
The Cube is a rectangular, six-sided box, defined by Width, Height and Depth.

Cube Definition:

Name

Give your shape a name.  This name will be displayed in the TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 

 macrobutton NextField Width

The width, in the X-axis, of the plane.

Height

The height, in the Y-axis, of the plane.

Depth

The depth, in the Z-axis, of the plane.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's translation from its origin.

Color / MaterialIDH_color_mat_l macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 
D macrobutton NextField ialog tab for setting the object's color and material.

TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's texture.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the object.

#$KSphere




{bmc sphere config.bmp} 
The Sphere is a circular shape.  The sphere is simulated by creating a number of flat planes around the radius of the sphere.

Sphere Definition:

Name

Give your shape a name.  This name will be displayed in the TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 

 macrobutton NextField Radius

The radius of the sphere.

Major Segments

The number of sides around the shapes Z-axis.

Minor Segments

The number of sides along the Z-axis.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's translation from its origin.

Color / MaterialIDH_color_mat_l macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 
D macrobutton NextField ialog tab for setting the object's color and material.

TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's texture.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the object.

#$KCone




{bmc cone config.bmp} 
The Cone is a pointed at the top and round at the bottom.  The cone is simulated by creating a number of flat planes around the radius of the base.

Cone Definition:

Name

Give your shape a name.  This name will be displayed in the TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 

 macrobutton NextField Base Radius

The radius of the base of the cone.

Major Segments

The number of sides around the shapes Z-axis.

Minor Segments

The number of sides along the Z-axis.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's translation from its origin.

Color / MaterialIDH_color_mat_l macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 
D macrobutton NextField ialog tab for setting the object's color and material.

TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's texture.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the object.

#$Cylinder




{bmc cylinder config.bmp} 
The Cylinder is a round tubular shape.  The cylinder is simulated by creating a number of flat planes around the radius of the base.

Cylinder Definition:

Name

Give your shape a name.  This name will be displayed in the TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 

 macrobutton NextField Base Radius

The radius of the base, or bottom, of the cylinder.

Top Radius

The radius of the top of the cylinder.

Major Segments

The number of sides around the shapes Z-axis.

Minor Segments

The number of sides along the Z-axis.

Solid Cyl

Set this flag if you want the cylinder to be rendered as a solid.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's translation from its origin.

Color / MaterialIDH_color_mat_l macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 
D macrobutton NextField ialog tab for setting the object's color and material.

TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's texture.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the object.

#$KDisk




{bmc disk config.bmp} 
The Disk is a flat circular shape.  The disk is simulated by creating a number of pie shaped wedges around the radius of the disk.  A disk has no thickness.

Disk Definition:

Name

Give your shape a name.  This name will be displayed in the TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 

 macrobutton NextField Outer Radius

The outer radius of the disk.

Segments

The number of sides around the shapes Z-axis.

Concentric Rings

The number of rings around the disk.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's translation from its origin.

Color / MaterialIDH_color_mat_l macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 
D macrobutton NextField ialog tab for setting the object's color and material.

TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's texture.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the object.

#$KTorus




{bmc torus config.bmp} 
The Torus is a circular donut shape.  The torus is simulated by creating a number of flat planes around the radius of the shape.

Torus Definition:

Name

Give your shape a name.  This name will be displayed in the TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 

 macrobutton NextField Major Radius

The radius of the torus's origin to the center of the torus ring.

Minor Radius

The radius of the torus ring.

Major Segments

The number of sides around the shapes Z-axis.

Minor Segments

The number of sides along the Z-axis.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's translation from its origin.

Color / MaterialIDH_color_mat_l macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 
D macrobutton NextField ialog tab for setting the object's color and material.

TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's texture.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the object.

#$KGrid




{bmc grid config.bmp} 

The Grid is a flat checker board shape.  The grid is made up of multiple planes.

Grid Definition:

Name

Give your object a name.  This name will be displayed in the TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 

 macrobutton NextField Width

The width of the grid in the X-axis.

Depth

The depth of the grid in the Y-axis.

'X'-Axis Divisions

The number of planes along the X-axis.

'Y'-Axis Divisions

The number of planes along the Y-axis.

Alt Color

This is the color used for every other grid plane.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's translation from its origin.

Color / MaterialIDH_color_mat_l macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 
D macrobutton NextField ialog tab for setting the object's color and material.

TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's texture.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the object.

#$KLathe




{bmc lathe config.bmp} 
The Lathe object is a circular shape defined and outlined by a set of points.  You first define a series of points which outlines the general shape of the object.  Once the points have been defined, the surfaces are 'sweeped' around the Z-Axis.  (Hence points should be defined in the XZ plane, or Front view)

Lathe Definition:

Name

Give your object a name.  This name will be displayed in the TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 

 macrobutton NextField Sweep Angle

The number of degrees that the points should be rotated, or sweeped around the Z-axis.

Segments

The number of sides around the objects Z-axis.

Smooth Faces

This flag indicates that the lathe surfaces should be smoothed.

Max. Angle between Smooth Faces

This angle defines the maximum angle between adjacent surfaces, or faces, which should be smoothed.  The smaller this number, the sharper the corners.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's translation from its origin.

Color / MaterialIDH_color_mat_l macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 
D macrobutton NextField ialog tab for setting the object's color and material.

TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's texture.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the object.

#$Kh-Spline

Not yet implemented.  Coming Soon! (h-splines?)

#$KNURB




{bmc nurb config.bmp} 
The NURB (Non-Uniform Rational B-spline) object is a free form object defined by the position of its' control points.  Useful for creating curved shapes.

NURB Definition:

Name

Give your object a name.  This name will be displayed in the TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 

 macrobutton NextField Size

The initial width along the x-axis and its' depth along the y-axis.

Segments

The number of sub-divided segments, or surfaces, that are to represent the shape.  Larger numbers provide smoother curves, but slower performance.

Grid Points

Defines the number of control points along the x and y-axis. Control points position the segments that make up the NURBS surface.  Larger numbers of control points allow for more complex curved surfaces.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's translation from its origin.

Color / MaterialIDH_color_mat_l macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 
D macrobutton NextField ialog tab for setting the object's color and material.

TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's texture.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the object.

#$KTrue Type Font




{bmc text config.bmp} 

The Text object is created from a True Type FontIDH_font_configuration macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  outline.

Text Definition:

Name

Give your object a name.  This name will be displayed in the TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 

 macrobutton NextField Character Depth

The depth of the text string in the Y-axis.

Select Font

Displays the selected True Type Font.  To change the font type, press the Select FontIDH_font_configuration macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  button.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's translation from its origin.

Color / MaterialIDH_color_mat_l macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 
D macrobutton NextField ialog tab for setting the object's color and material.

TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's texture.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the object.

#$KFont configuration




{bmc font config.bmp} 
This is the standard Windows True Type Font dialog configuration box.

#$KCSG (Constructive Solid Geometry)




{bmc csg config.bmp} 
The CSG object is comprised of multiple shapes. 

Bug Note:  This object does not render correctly with other objects in the scene. (
                   Work in process..

CSG Definition:

Name

Give your shape a name.  This name will be displayed in the TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 

 macrobutton NextField A or B

Draws shape 'A' Boolean OR'ed with shape 'B'.  This selected draws all child shapes of the parent CSG object.

A sub B

Draws shape 'A' subtracted from shape 'B'.  Only child shapes A and B will be rendered.

B sub A

Draws shape 'B' subtracted from shape 'A'.  Only child shapes A and B will be rendered.

A and B

Draws shape 'A' Boolean AND'ed with shape 'B'.  This renders the intersection where A intersects B.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's translation from its origin.

Color / MaterialIDH_color_mat_l macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 
D macrobutton NextField ialog tab for setting the object's color and material.

TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's texture.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the object.

#$KTerrain




{bmc terrain config.bmp} 
The Terrain object is generated from a fractal grid array.   The fractal grid array can be tiled to create a mosaic terrain effect.

Terrain Definition:

Name

Give your shape a name.  This name will be displayed in the TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 

 macrobutton NextField Random Terrain Height

Select this option to generate a random terrain height grid.

Terrain Pattern

This is a Non-Negative integer number used to seed the fractal grid height array.

Width

The width of the terrain grid in the X-axis.

Depth

The depth of the terrain grid in the Y-axis.

Grid Size

Defines the number of grid points which make up the terrain point array.  Higher numbers will generate a more detailed terrain map at the cost of DECREASING performance.

Tile Terrain

This is an integer number from 1 to 32767 which defines the number of times to 'Tile' the basic terrain shape in both width and depth.  I.E., a tile size of 4 will draw 'tile' the terrain grid 4 times in the y-axis, and 4 times in the x-axis for a total of 16 repeated terrain grids.

Height Slider

The height slider is used to vary the height map of the random fractal grid points.  The higher the slider, the higher the terrain.

Sea Level Slider

The Sea Level slider is used to vary the water, or sea level height.  The higher the slider, the higher the water level.

Terrain ColorIDH_terrain_color macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the Terrain's Color.

Terrain TextureIDH_terrain_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the Terrain's Textures.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's translation from its origin.

Color / MaterialIDH_color_mat_l macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 
D macrobutton NextField ialog tab for setting the object's color and material.

TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's texture.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the object.

#$KTerrain Color




{bmc terrain color config.bmp} 
The Terrain Color dialog is used to configure the color parameters of the terrain object.  The preview window will display the approximate terrain settings.

Terrain Color Definition:

Solid Color

If this option is selected, the terrain is drawn with the object's solid color.

Gradient Color

This option will draw the terrain object with the four gradient colors defined below.

Gradient Color Attributes

Snow  - The color used to paint the terrain peaks.

Rock   - The color used to paint the terrain mid level, or rocky area.

Grass - The color used to paint the terrain grass lands.

Water - The color used to paint the terrain water level.

Reflective Snow / Water

This option, if selected, caused light to be reflected off the snow and water colors.

Color Button (Button under the preview window)


The color button is used to set the associated gradient color.  

Note:  To set a gradient color, first select the gradient color you want to modify, say Rock.  Next, select the Color Button.  This will bring up the Color Dialog, allowing you to choose the color you want for the 'Rock'.  Repeat for other selections as necessary.
#$KTerrain Texture




{bmc terrain texture config.bmp} 
The Terrain Texture dialog is used to control the texture mapping effects onto the terrain object.  Currently, texture maps can be applied only to the complete grid, or to each sub-grid polygon.  We are in the process of experimenting with sub-grid textures as applied to varying height fields.  Note that this feature is not available at this time.

Terrain Texture Definition:

Map Texture To Grid

This option maps the selected Texture Map file across the entire terrain grid.

Map Texture to sub-grid

This option maps the selected Texture Map file across each sub-grid.  I.e.  If the terrain grid selected is 32 x 32, then the texture map will be mapped to EACH of the 32x32, or 1024 sub-grid polygons.

Terrain Pattern

This is a Non-Negative integer number used to seed the fractal grid height array.

The lower portion of the Terrain Texture dialog displays the texture map file attached to the selected object and provides you a method for attaching, editing and removing texture maps.  Texture maps are bitmap images which are 'wrapped' around the selected object.  Currently supported textures include:


Windows bitmap images. (*.bmp)


AVI movies.  (*.avi)

Texture Map File Name


The name of the texture map file attached to this object.

Open Texture


Pressing this button displays the standard Windows File OpenAFX_HIDD_FILEOPEN macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  dialog box.

Edit Texture


Press this button to display the Texture AttributesIDH_texture_attributes macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  dialog box.  This provides detailed texture mapping control.IDH_color_attributes_dialog
Remove


Pressing this button removes the texture map from the object.

#$KCloud / Ground Fog Objects




{bmc cloud config.bmp} 
The Cloud / Ground Fog object will generate a fractal texture map which emulates clouds and ground fog. This texture map can be tiled to create a larger mosaic cloud effect.

Cloud Definition:

Name

Give your shape a name.  This name will be displayed in the TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 

 macrobutton NextField Random Cloud Pattern

Select this option to generate a random cloud pattern.

Cloud Pattern

This is a Non-Negative integer number used to seed the cloud fractal array.

Width

The width of the cloud texture map in the X-axis.

Depth

The depth of the cloud texture map in the Y-axis.

Tile Cloud Pattern

This is an integer number from 1 to 32767 which defines the number of times to 'Tile' the basic cloud shape in both width and depth.  I.E., a tile size of 4 will draw 'tile' the terrain grid 4 times in the y-axis, and 4 times in the x-axis for a total of 16 repeated cloud objects.

Density Slider

The Density slider is used to vary the density of the cloud. The higher the slider, the more dense the cloud.

Scattered/Continuous Slider

This slider is used to configure the 'smoothness' of the cloud pattern.

Cloud ColorIDH_cloud_color macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the Cloud's Color.

OriginIDH_origin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's origin.

RotationIDH_rotation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's rotation about the world origin.

ScaleIDH_scale macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's scale.

TranslationIDH_translation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's translation from its origin.

Color / MaterialIDH_color_mat_l macrobutton NextField  macrobutton DoJump2 <+>
 macrobutton NextField 
D macrobutton NextField ialog tab for setting the object's color and material.

TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for setting the object's texture.

AnimationIDH_animation macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  

Dialog tab for animating the object.

#$KCloud Color




{bmc cloud color config.bmp} 
The Cloud Color dialog is used to configure various cloud/ground fog effects as described below.

Cloud Color Definition:

Opacity Slider

The Opacity slider is used to control the transparency value of the cloud.  With the slider fully to the right, the cloud has minimal transparency.

Highlight Color Button

Press this button to set the cloud's highlight color.

Edge Color Button

Press this button to set the cloud's edge color.

Tile Texture

This is an integer number ranging from 1 to 32767 which defines the number of times to 'Tile' the basic cloud texture within the clouds width and height.

Texture Pixel Grid

Defines the texture pixel grid size. Higher numbers will generate a more detailed cloud texture map at the cost of consuming additional texture memory.  Performance degradation is minimal.

#$KSelecting objects

To select an Object, click on the object in the Tree ViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>


 macrobutton NextField  ADDIN 



 macrobutton NextField 

 macrobutton NextField 
 macrobutton NextField 
 window.  An alternate method would be to click on the "Parent Object" (or Child Object) SelectionIDH_toolbar_selections macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  toolbar button, click on the "Select" button in the CommandsIDH_toolbar_commands macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  toolbar, then left mouse click on the object that you want to select.

Selected objects are outlined with a red bounding box.




{bmct object selected.bmp} 
#$KEditing attributes

To edit the attributes of an object or light, double-click the object that you want to edit in either the scene or in the Tree ViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>


 macrobutton NextField  ADDIN 



 macrobutton NextField 

 macrobutton NextField 
 macrobutton NextField 
 window.  Once the object dialog is displayed, click the tab of the attribute you wish to edit.

#$KOrigin




{bmc origin config.bmp} 
The Origin is the 3d point, (x,y,z) about which an object is defined. 

X-Axis

The origins dimension along the X-axis relative to the world's origin.

Y-Axis

The origins dimension along the Y-axis relative to the world's origin.

Z-Axis

The origins dimension along the Z-axis relative to the world's origin.

#$KRotation




{bmc rotation config.bmp} 
The Rotation values represent the angle of rotation about the X, Y and Z-axis, expressed in degrees.

X-Axis

The angle of rotation about the X-axis.

Y-Axis

The angle of rotation about the Y-axis.

Z-Axis

The angle of rotation about the Z-axis.

#$KScale




{bmc scale config.bmp} 
The Scale value represent the relative size of the object.  A scale factor of 2.0 in the X, Y and Z-axis will increase the size of the object twice its normal size.

X-Axis

The relative scale of the object along the X-axis.

Y-Axis

The relative scale of the object along the Y-axis.

Z-Axis

The relative scale of the object along the Z-axis.

#$KTranslation




{bmc translation config.bmp} 
The Translation values represent an objects relative movement relative to its origin.

X-Axis

The relative movement of the object along the X-axis.

Y-Axis

The relative movement of the object along the Y-axis.

Z-Axis

The relative movement of the object along the Z-axis.

#$KColor / Mat'l




{bmc color_matl config.bmp} 
The Color / Material  properties determine what color the object is rendered and define how light is reflected from the objects surface(s).

Color List



A drop-down list box containing a list of all user define colors.  To define colors, see



Defining Colors dialogIDH_defining_colors_dialog macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField .
Current Color

A Color selection button displaying the currently selected color.  Pressing this button will display the Color AttributesIDH_color_attributes_dialog macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  dialog box.

Material List

A drop-down list box containing a list of all user defined materials.  To define materials, see Edit Material AttributesIDH_edit_material_attrubutes macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField . 

#$KColor Attributes dialog




{bmct color attributes dialog.bmp} 

The Color Attributes dialog box allow you to select a color from the color palette cube.

Color Cube


By left-clicking on the Color Palette Cube, you select the color located directly under the cross-hair cursor.  The color cube can be rotated to display varying colors.

Right Color Slider


A slider control is located on the right side of the Color Palette Cube that allows finer color gradient of the selected color.

Red   Green   Blue   Alpha

The RGBA color components of the selected color.

Color Drop-Down List box


Contains a list of all user define colors.  To define colors, see Defining Colors dialogIDH_defining_colors_dialog macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField .
#$KEdit Colors Dialog




{bmc edit colors.bmp} 

The Edit Colors dialog displays a list of all user defined colors.  By coloring objects with pre-defined colors, you can achieve consistent coloring from object to object.

Color Name


The name of the color you wish to define.

Selected Color


A Color selection button displaying the currently selected color.  Pressing this button will display the Color AttributesIDH_color_attributes_dialog macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  dialog box.

Color List

A list of all pre-defined colors.  Clicking a color name in the list box will select it as the current color.

Red   Green   Blue   Alpha

The RGBA color components of the selected color.

New


A button used to create a New color.  Pressing this button will display a dialog box for user input.

#$KEdit Material Attributes




{bmc material dialog.bmp} 
The Edit Material Attributes dialog displays a list of all user defined materials and allow you to edit their attributes. Materials define how light is reflected and emitted from objects

Material Name


The name of the material you wish to define.

Material List

A list of all pre-defined materials. Clicking a material name in the list box will select it as the current material.

Ambient Color


A selection drop-down list box and button displaying the currently selected ambient color component.  Regardless of lighting conditions, this color component will be added to the diffuse, specular and emissive color components for each pixel of the surface rendered.  Pressing this button will display the Color AttributesIDH_color_attributes_dialog macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  dialog box.

Diffuse Color


A selection drop-down list box and button displaying the currently selected diffused color component.  Diffused color represents the amount of reflected light 'scattered' from its surface. Pressing this button will display the Color AttributesIDH_color_attributes_dialog macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  dialog box.

Specular Color


A selection drop-down list box and button displaying the currently selected specular color component.  Specular color component depends significantly on the angle of incidence of the light source(s). Pressing this button will display the Color AttributesIDH_color_attributes_dialog macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  dialog box.

Emissive Color


A selection drop-down list box and button displaying the currently selected emissive color component.  Emissive color is used for materials that appear to give off their own light. Pressing this button will display the Color AttributesIDH_color_attributes_dialog macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  dialog box.

Specular Power

A value ranging from 0 to 128, with smaller values producing larger specular highlight on the material surface.

Translucency

Not currently used.

Index of Refraction

Not currently used.

New


A button used to create a New material.  Pressing this button will display a dialog box for user input.

#$KTexture




{bmc texture config.bmp}
The Texture dialog displays the texture map file attached to the selected object and provides you a method for attaching, editing and removing texture maps.  Texture maps are bitmap images which are 'wrapped' around the selected object.  Currently supported textures include:


Windows bitmap images. (*.bmp)


AVI movies.  (*.avi)

Texture Map File Name


The name of the texture map file attached to this object.

Open Texture


Pressing this button displays the standard Windows File OpenAFX_HIDD_FILEOPEN macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  dialog box.

Edit Texture


Press this button to display the Texture AttributesIDH_texture_attributes macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  dialog box.  This provides detailed texture mapping control.IDH_color_attributes_dialog
Remove


Pressing this button removes the texture map from the object.

#$KTexture Attributes




{bmc texture attributes dialog.bmp} 

The Texture Attributes dialog displays many possible setting for your texture maps.  Experiment with various setting to see different effects.

#$+KAnimation procedures

 macrobutton  InsertButton [Browse Animations]{button Browse Animations,BrowseButtons()} 




{bmc animation config.bmp} 
The Animation procedure dialog provides you a means to select animation procedures from a list and configure your animation procedures.

Selected Procedures


This is a list box that displays the selected procedures for the selected object.  Clicking on a procedure in the list highlights and selects the animation procedure.

Available Procedures

This is a list box that displays the available animation procedures.  Clicking on a procedure

in the list highlights and selects the animation procedure.

<-Add

Press this button to add the highlighted animation procedure from the Available Procedures

list to the Selected Procedures list.

Delete


Pressing this button removes the highlighted animation procedure from the Selected Procedures list.

Configure Procedure


Pressing this button displays the Configure AnimationIDH_animation___spin macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  dialog box that allows you to select and configure all animation procedures listed in the Selected Procedures list.

#$+KAnimation - Spin




{bmc animation spin config.bmp} 
The Animation - Spin procedural dialog provides you a means to configure how an objects is spun, or rotated about its origin.

Degrees

This represents the number of degrees that the object should be rotated about the X, Y, and Z axis per iteration.

Per Second

This describes how fast the animation procedure is to rotate the object about the axis.  If you enter 0 into the Per Second column, the object will rotate about the prescribed axis <N> Degrees per scene update.  (rotate as Fast as it can..)

Example:

You want the object to rotate about the x-axis 360 degrees every 10 seconds.  Enter 360 into the X-Axis Degrees and 10 into the Per Second column.

#$+KAnimation - Wobble




{bmc animation wobble config.bmp} 

The Animation - Wobble procedural dialog provides you a means to configure how an objects is 'wobbled' about its origin.

Degrees

This represents the number of degrees that the object should be rotated about the X, Y, and Z axis per iteration.

Per Second

This describes how fast the animation procedure is to rotate the object about the axis.  If you enter 0 into the Per Second column, the object will rotate about the prescribed axis <N> Degrees per scene update.  (Rotate as Fast as it can..)

Example:

You want the object to rotate about the x-axis 360 degrees every 10 seconds.  Enter 360 into the X-Axis Degrees and 10 into the Per Second column.

Limit

This describes how far the object can rotate before it must reverse direction and rotate in the opposite direction.  The limit factor is treated as +/ <n> degrees about the prescribed axis.

# +$KAnimation - KeyFrame




{bmc animation keyframe config.bmp} 

The Animation - KeyFrame procedural dialog provides you a means to configure an objects keyframe sequence.

Number of Keyframes

This is a non-editable box displaying the number of keyframes recorded.  To record a keyframe, see the KeyFrame ToolbarIDH_toolbar_keyframe macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField .

Cycle KeyFrames

This radio button enables you to force the keyframe animation sequence to cycle back to the beginning after completion.  This will loop until the animation sequence is stopped.

# +$KAnimation - AVI Movie




{bmc animation avi movie config.bmp} 
The Animation - AVI Movie procedural dialog provides you a means to configure an objects AVI movie file animation sequence.  This animation procedure is automatically added to the objects selected animation procedures if you attach an AVI movie texture.  See the TextureIDH_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField  attributes dialog for adding texture maps.

AVI Texture File Name:

This displays the name and file path of the avi movie file.

Continuous Play

This radio button enables you to force the avi movie file to continuously replay until the animation sequence is stopped.

Enable Audio Track

This radio button enables the audio track if present.

Audio Control

Volume - A slider for controlling the volume of the audio device. audio track if present.

Pitch     - Currently not used.

#$KTips & Tricks

#$KFrequently Asked Questions

Q.
I don't understand how to record keyframes. What does the 'Record' keyframe button do? What does it record?

A.
The Record Keyframe pushbutton, records the time, location, rotation, scale and color of the currently selected object (shape or light).

The idea behind keyframe animation is to set the objects' parameters and attributes as you want them displayed at the 'time' frame you want. You record 'keyframe' object data at critical time intervals.  Based on the speed of your computer, the program will interpolate the object values between keyframes and smooth the animation between frames.

As an example, create and select a sphere.  The 'time' reference should show 0.0sec.:

1.
Press the record button to save the default object parameters

2.
Move the object to a desired location

3.
Enter a new 'time' for the next keyframe (try 10.0)

4.
Select a new color for the sphere. (select from the color cube or by


double clicking on the object, select color/mat'l, current color)

5.
Press the record button.

Now you are ready to play the animation.  Select Animate/Screen from the menu.  You should see the sphere start at the default location with its default parameters moving to the location you selected at 'time' base 10.0sec. You should also see it change color along the way.

Q.
Help!  I've resized the TreeView toolbar and moved it to a docking location at the top (or bottom) of the screen and I can no longer move it back to the side or make it smaller.  What do I do?

A.
The only way to 'fix' this problem is to save the 3D scene you are working on, exit ModelMagic3D, open the Windows Explorer window, select the Windows (or WinNT) directory located on the hard drive (usually C:\Windows), find and DELETE the ModelMagic3D.ini file.  When ModelMagic3D is started again, it will create a default configuration file.

#$KTrouble Shooting

Q.
Help!  I can't get the animation feature to work.  I have a Packard Bell 200MMX Pentium with a Diamond 2D card and a Creative Labs Voodoo 2 card.  I have experienced no conflicts with other software.  Any suggestions?

A.
There have been reported problems with the voodoo 2 OpenGL drivers.

Do you have the latest drivers installed?  I checked the 3dfx web site and checked the news groups.  They mentioned that 3dfx will be releasing their latest IDC OpenGL drivers sometime in February, 1999.  Until then, you may want to download their Beta driver at:

http://www.3dfx.com/docs/opengl_beta/opengl_beta.html!EF(`webdial.exe', `>http://www.3dfx.com/docs/opengl_beta/opengl_beta.html', 1, `')  

ModelMagic3D has been tested with Diamonds 2D card, their FireGL 

1000 card and the TNT V550 card.  All worked fine.

#$KMenu Commands

The following commands are available from the main menu:

File menumenu_file macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Edit menumenu_edit macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 
View menumenu_view macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Objects menumenu_objects macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Colors menumenu_colors macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Material menumenu_material macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Texture menumenu_texture macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Tools menumenu_tools macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  

Animate menumenu_animate macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Window menumenu_window macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Help menumenu_help macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
#K $ File menu commands
The File menu offers the following commands:

NewHID_FILE_NEW macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Creates a new document.

OpenHID_FILE_OPEN macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Opens an existing document.

CloseHID_FILE_CLOSE macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Closes an opened document.

SaveHID_FILE_SAVE macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Saves an opened document using the same file name.

Save AsHID_FILE_SAVE_AS macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Saves an opened document to a specified file name.

Save ImageHID_FILE_SAVE_IMAGE macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Saves the image to a file.

PrintHID_FILE_PRINT macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Prints a document.

Print PreviewHID_FILE_PRINT_PREVIEW macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Displays the document on the screen as it would appear printed.

Print SetupHID_FILE_PRINT_SETUP macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Selects a printer and printer connection.

Page SetupHID_FILE_PAGE_SETUP macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Selects the page or image setup configuration.

1, 2, 3, 4HID_FILE_MRU_FILE1 macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Corresponds to the last four (4) files you saved.  

ExitHID_APP_EXIT macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 



Exits ModelMagic3D.

#$KNew command (File menu)
Use this command to create a new document in ModelMagic3D. 

You can open an existing document with the Open commandHID_FILE_OPEN macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField .

Shortcuts

Toolbar:



{bmc filenew.bmp}
Keys:
CTRL+N

#K $ Open command (File menu)
Use this command to open an existing document in a new window.  ModelMagic3D will display the File Open dialog boxAFX_HIDD_FILEOPEN macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  for file selection.  You can open multiple documents at once.  Use the Window menu to switch among the multiple open documents.  See Window 1, 2, ... commandHID_WINDOW_ALL macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField .

You can create new documents with the New commandHID_FILE_NEW macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField .

Shortcuts

Toolbar:



{bmc fileopen.bmp}
Keys:
CTRL+O

#$File Open dialog box




{bmc fileopen dialog.bmp} 
The File Open dialog box allows you to specify the type of the file and the name of the file to open.

Look in:

Select the directory in which you want to open the file from.

File Name

The name of the file you wish to open.  Names can be typed or selected from the available list.  

Files of type:

This is a drop-down list box containing the file type. ModelMagic3D supports the following file formats:

3D Worlds:



Native format. (*.wld)
Objects:



Native format. (*.obj)

Materials:



Native format. (*.mtl)
Texture Maps:



Windows bitmaps. (*.bmp)


AVI movies. (*.avi)
The following options allow you to specify which file to open:

File Name

Type or select the filename you want to open.  This box lists files with the extension you select in the List Files of Type box. 

List Files of Type

Select the type of file you want to open:


ModelMagic3D currently supports only files with the .wld extension

Drives

Select the drive in which ModelMagic3D stores the file that you want to open. 

Directories

Select the directory in which ModelMagic3D stores the file that you want to open.

Network...

Choose this button to connect to a network location, assigning it a new drive letter. 

#K $ Close command (File menu)
Use this command to close all windows containing the active document.  ModelMagic3D suggests that you save changes to your document before you close it.  If you close a document without saving, you lose all changes made since the last time you saved it.  Before closing an untitled document, ModelMagic3D displays the Save As dialog boxAFX_HIDD_FILESAVE macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  and suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown below:




{bml scmenu.bmp}
#K $ Save command (File menu)
Use this command to save the active document to its current name and directory.  When you save a document for the first time, ModelMagic3D displays the Save As dialog boxAFX_HIDD_FILESAVE macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  so you can name your document.  If you want to change the name and directory of an existing document before you save it, choose the Save As commandHID_FILE_SAVE_AS macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField .

Shortcuts

Toolbar:



{bmc filesave.bmp}
Keys:
CTRL+S

#K $ Save As command (File menu)
Use this command to save and name the active document.  ModelMagic3D displays the Save As dialog boxAFX_HIDD_FILESAVE macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  so you can name your document.  

To save a document with its existing name and directory, use the Save commandHID_FILE_SAVE macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField .

#$File Save As dialog box




{bmc file save as.bmp} 
The Save As dialog box allows you to specify the name and location of the file you're about to save.

Save in:

Select the directory in which you want to store the document.

File Name

The name of the file or document you want to save.  You can type a new filename to save a document with a different name, or select and existing file to over-write an existing file.  ModelMagic3D supports long file names and follows the standard Windows naming conventions for files.

Save as type

This is a drop-down list box containing the file type. ModelMagic3D supports the following file formats:

3D Worlds:



Native format. (*.wld)
Objects:



Native format. (*.obj)

Materials:



Native format. (*.mtl)
Texture Maps:



Windows bitmaps. (*.bmp)


AVI movies. (*.avi)
# K $ 1, 2, 3, 4 command (File menu)
Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you closed.  Choose the number that corresponds with the document you want to open.

#K $ Exit command (File menu)
Use this command to end your ModelMagic3D session.  You can also use the Close command on the application Control menu.  ModelMagic3D prompts you to save documents with unsaved changes.

Shortcuts

Mouse:
Double-click the application's Control menu button.





{bmc appexit.bmp}
Keys:
ALT+F4

#Edit menu commands
The Edit menu offers the following commands:

UndoHID_EDIT_UNDO macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Reverse previous editing operation.

CutHID_EDIT_CUT macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Deletes data from the document and moves it to the clipboard.

CopyHID_EDIT_COPY macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Copies data from the document to the clipboard.

PasteHID_EDIT_PASTE macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Pastes data from the clipboard into the document.

Note:  These features are not yet implemented!

#View menu commands
The View menu offers the following commands:

Display Grid
Toggle the grid On/Off.

Display Axis
Toggle the world origin and selected object axis On/Off.

Display Multi-View
Display the selected world in Iso, Front, Side and Top views.

Display Mode


    Wireframe
Render the surfaces in wireframe

    Flat Shade
Render the surfaces flat shaded.

    Smooth Shade
Render the surfaces smooth shaded.  More realistic.

    Raytrace
Not yet Implemented.

Perspective
Toggle Perspective / Orthographic view

Iso
Move camera to default Isometric view

XZ (Front)
Move camera to Front view

YZ (Side)
Move camera to Side view

XY (Top)
Move camera to Top view

Cull Faces
Render front surfaces only.  Speeds rendering.

Pan
Not yet Implemented.

Zoom In
Move the camera view closer to the world origin

Zoom Out
Move the camera view further from the world origin




#Objects menu commands

The Objects menu offers the following commands:

OpenAFX_HIDD_FILEOPEN macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField   macrobutton NextField  
Open an object file and attach as a child object of the selected object.

Save AsAFX_HIDD_FILESAVE macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField   
Save the selected object and all of its children.

2d Objects >


    DiskIDH_disk macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Create a new Disk shape.

    TriangleIDH_triangles macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Create a new Triangle shape.

    PlaneIDH_plane macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Create a new Plane shape.

    GridIDH_grid macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Create a new Grid shape.

3d Objects >


    ConeIDH_cone macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Create a new Cone shape.

    CylinderIDH_cylinder macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Create a new Cylinder shape.

    CSGIDH_csg__constructive_solid_geometry macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Create a new CSG shape.

    CubeIDH_cube macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Create a new Cube shape.

    LatheIDH_lathe macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Create a new Lathe shape.

    h-SplineIDH_lathe macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Create a new h-Spline object.

    NURBIDH_nurb macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Create a new NURB shape.

    SphereIDH_sphere macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Create a new Sphere shape.

    TorusIDH_torus macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Create a new Torus shape.

    TextIDH_true_type_font macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Create a new True Type Font Text shape.

    Extrude
Not yet Implemented

Scene Objects >


    LightsIDH_light macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  IDH_light macrobutton NextField 

 macrobutton NextField  
Create a Light object.  (Directional, Positional, Spot, or Ambient light)

    Terrain
Not yet Implemented

    Sky
Not yet Implemented

#Colors menu commands

The Objects menu offers the following commands:

OpenAFX_HIDD_FILEOPEN macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField   macrobutton NextField  
Not yet Implemented

Save AsAFX_HIDD_FILESAVE macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField   
Not yet Implemented

Edit ColorsIDH_defining_colors_dialog macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Edit the applications user defined colors.

#Material menu commands

The Objects menu offers the following commands:

OpenAFX_HIDD_FILEOPEN macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField   macrobutton NextField  
Open an object file and attach as a child object of the selected object.

Save AsAFX_HIDD_FILESAVE macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField   
Save the selected object and all of its children.

Edit MaterialsIDH_edit_material_attrubutes macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Rotate the selected object while depressing the Left Mouse Button. 

#Texture menu commands

The Objects menu offers the following commands:

Open Texture MapAFX_HIDD_FILEOPEN macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField   macrobutton NextField  
Open a texture map file and associates it with the selected object.

Remove Texture Map 
Removes the texture map from the selected object.

Edit Texture MapIDH_texture_attributes macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Edits the texture map associated with the selected object.

#Tools menu commands

The Tools menu offers the following commands:

ToolBars >
The following are floating toolbars which can be shown or hidden:

     Tool BarIDH_toolbar macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Shows or hides the toolbar.

     Status BarHID_VIEW_STATUS_BAR macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 
Shows or hides the status bar. 

     TreeViewIDH_toolbar_treeview macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField   
Shows or hides the TreeView window.

     Color PaletteIDH_toolbar_color_palette macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 
Shows or hides the Color Palette window.

     CoordinatesIDH_toolbar_coordinates macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Shows or hides the Coordinates toolbar.

     Selection BarIDH_toolbar_selections macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Shows or hides the Selection toolbar.

     Command BarIDH_toolbar_commands macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Shows or hides the Command toolbar.

     Scene Objects BarIDH_toolbar_scene_objects macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Shows or hides the Scene Objects toolbar.

     2D Shape BarIDH_toolbar_2d_shapes macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Shows or hides the 2D Objects toolbar.

     3D Shape BarIDH_toolbar_3d_shapes macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Shows or hides the 3D Objects toolbar.

     Keyframe Animation BarIDH_toolbar_keyframe macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Shows or hides the Keyframe Animation bar.

SelectIDH_toolbar_selections macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField   >


     Camera
Commands are to be applied to the Camera.

     Parent Object
Commands are to be applied to the Parent Object.

     Child Object
Commands are to be applied to the selected Child Object.

     Object


          Axis
Commands are to be applied to the selected objects Axis.

          Texture
Commands are to be applied to the selected objects' Texture.

          Texture Axis
Commands are to be applied to the selected objects' Texture Axis.

          Edges
Commands are to be applied to the selected objects' Edges.

          Points
Commands are to be applied to the selected objects' Points.

     Points
Commands are to be applied to the selected Point.

CommandsIDH_toolbar_commands macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField   >


     Select
Select the item.

     Move
Move the selected item in 3D space.

     Rotate
Rotate the selected item in 3D space.

     Scale
Scale the selected item.

     Paint Object
Paint the selected object with the Color toolbar's current color.

     Create Points
Create new points.

Coordinates >


     X-Axis  Lock/Unlock
Enable/Disable mouse coordinates along the X-Axis.

     Y-Axis Lock/Unlock
Enable/Disable mouse coordinates along the Y-Axis.

     Z-Axis Lock/Unlock
Enable/Disable mouse coordinates along the Z-Axis.

     World System
Displays object coordinates relative to the World coordinate system.

     Object Coordinates
Displays object coordinates relative to the parent objects' coordinate system.

Snap To Grid
Forces the mouse coordinates to grid points.

Preferences
Not yet Implemented.

Edit CameraIDH_camera_configuration macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Displays the camera edit dialog.




#Animate menu commands

FlyHID_VIEW_TOOLBAR macrobutton NextField 

 macrobutton NextField  
Fly through the scene using the Up/Down/Left/Right arrow keys.

ScreenHID_VIEW_STATUS_BAR macrobutton NextField 

 macrobutton NextField  
Shows or hides the status bar. 

KeyframeIDH_toolbar_keyframe macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField   


    RecordHID_VIEW_TOOLBAR macrobutton NextField 

 macrobutton NextField  
Record an objects attributes at the 'time' interval displayed. 

    UnRecordHID_VIEW_TOOLBAR macrobutton NextField 

 macrobutton NextField  
Erase the keyframe from the selected object keyframe list.

    PlayHID_VIEW_TOOLBAR macrobutton NextField 

 macrobutton NextField  
Play the keyframe sequence only for the selected object.

Unsupported at this time.  

    FirstHID_VIEW_TOOLBAR macrobutton NextField 

 macrobutton NextField  
Rewind to the first keyframe in the list.

    PreviousHID_VIEW_TOOLBAR macrobutton NextField  
Rewind to the previously recorded keyframe.

    NextHID_VIEW_TOOLBAR macrobutton NextField 

 macrobutton NextField  
Fast forward to the next recorded keyframe.

    LastHID_VIEW_TOOLBAR macrobutton NextField 

 macrobutton NextField  
Fast forward to the last recorded keyframe in the list.

    DecreaseHID_VIEW_TOOLBAR macrobutton NextField 

 macrobutton NextField  
Decrease the time interval by one second.

    IncreaseHID_VIEW_TOOLBAR macrobutton NextField 

 macrobutton NextField  
Increase the time interval by one second.




#Window menu commands
The Window menu offers the following commands, which enable you to arrange multiple views of multiple documents in the application window:

New WindowHID_WINDOW_NEW macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Creates a new window that views the same document.

CascadeHID_WINDOW_CASCADE macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Arranges windows in an overlapped fashion.

TileHID_WINDOW_TILE macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Arranges windows in non-overlapped tiles.

Arrange IconsHID_WINDOW_ARRANGE macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Arranges icons of closed windows.

Window 1, 2, ...HID_WINDOW_ALL macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Goes to specified window.

#Help menu commands
The Help menu offers the following commands, which provide you assistance with this application: 

Help TopicsHID_HELP_INDEX macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Offers you an index to topics on which you can get help.

About ModelMagic3DHID_APP_ABOUT macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField   macrobutton NextField  
Displays the version number of this application.

OpenGL Diagnostics
Displays driver information on your OpenGL display driver.

Visit Our Web Site
Opens your default web browser and directs you to our web site.

Send Help Request
Opens your default email editor and places the appropriate send to:  information into the header.

Order FormIDH_registering macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  
Directs you to our order form.

Order Online
Opens your default web browser and directs you to our secure online web server.

#Undo/Can't Undo command (Edit menu)
<< Your application's user interface for Undo may differ from the one described below.  Modify this help text accordingly. >>

Use this command to reverse the last editing action, if possible.   The name of the command changes, depending on what the last action was.  The Undo command changes to Can't Undo on the menu if you cannot reverse your last action.

Shortcuts

Toolbar:



{bmc editundo.bmp}
Keys:
CTRL+Z or


ALT-BACKSPACE


#Redo command (Edit menu)
<< Write application-specific help here. >>

#Cut command (Edit menu)
Use this command to remove the currently selected data from the document and put it on the clipboard.  This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:



{bmc editcut.bmp}
Keys:
CTRL+X

#Copy command (Edit menu)
Use this command to copy selected data onto the clipboard.  This command is unavailable if there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:



{bmc editcopy.bmp}
Keys:
CTRL+C

#Paste command (Edit menu)
Use this command to insert a copy of the clipboard contents at the insertion point.  This command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:



{bmc editpast.bmp}
Keys:
CTRL+V

#K $ Toolbar command (View menu)
Use this command to display and hide the Toolbar, which includes buttons for some of the most common commands in ModelMagic3D, such as File Open.  A check mark appears next to the menu item when the Toolbar is displayed.

See ToolbarIDH_toolbar macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField 

 macrobutton NextField  for help on using the toolbar.

#K $ Toolbar



{bml hlptbar.bmp}
The toolbar is displayed across the top of the application window, below the menu bar.  The toolbar provides quick mouse access to many tools used in ModelMagic3D,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

<< Add or remove toolbar buttons from the list below according to which ones your application offers. >>

Click
To



{bmc filenew.bmp}
Open a new document.




{bmc fileopen.bmp}
Open an existing document.  ModelMagic3D displays the Open dialog box, in which you can locate and open the desired file.




{bmc filesave.bmp}
Save the active document or template with its current name.  If you have not named the document, ModelMagic3D displays the Save As dialog box.




{bmc fileprnt.bmp}
Print the active document.




{bmc editcut.bmp}
Remove selected data from the document and stores it on the clipboard.




{bmc editcopy.bmp}
Copy the selection to the clipboard.




{bmc editpast.bmp}
Insert the contents of the clipboard at the insertion point.




{bmc editundo.bmp}
Reverse the last editing.  Note:  You cannot undo some actions.




{bmc recfirst.bmp}
Go to the first record in the current selection.




{bmc recprev.bmp}
Go to the previous record in the current selection.




{bmc recnext.bmp}
Go to the next record in the current selection.




{bmc reclast.bmp}
Go to the last record in the current selection.

#K $Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to the menu item when the Status Bar is displayed.

See Status BarAFX_HIDW_STATUS_BAR macrobutton NextField  macrobutton DoJump2 <+>

 macrobutton NextField 

 macrobutton NextField  for help on using the status bar.

#$KStatus Bar



{bml hlpsbar.bmp}
The status bar is displayed at the bottom of the ModelMagic3D window.  To display or hide the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through menus.  This area similarly shows messages that describe the actions of toolbar buttons as you depress them, before releasing them.  If after viewing the description of the toolbar button command you wish not to execute the command, then release the mouse button while the pointer is off the toolbar button.

When you are moving the mouse within the area of a 3D world, the cursor coordinates are displayed as:  


'X' = x.xx,  'Y' = y.yy,  'Z' = z.zz

The right areas of the status bar indicate which of the following keys are latched down:

Indicator
Description
CAP
The Caps Lock key is latched down.

NUM
The Num Lock key is latched down.

SCRL
The Scroll Lock key is latched down.

#New command (Window menu)
Use this command to open a new window with the same contents as the active window.  You can open multiple document windows to display different parts or views of a document at the same time.  If you change the contents in one window, all other windows containing the same document reflect those changes.  When you open a new window, it becomes the active window and is displayed on top of all other open windows.

#Cascade command (Window menu)
Use this command to arrange multiple opened windows in an overlapped fashion. 

#Tile command (Window menu)
Use this command to arrange multiple opened windows in a non-overlapped fashion.

#Tile Horizontal command (Window menu)
Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.

#Tile Vertical command (Window menu)
Use this command to arrange multiple opened windows side by side.

#Window Arrange Icons Command
Use this command to arrange the icons for minimized windows at the bottom of the main window.  If there is an open document window at the bottom of the main window, then some or all of the icons may not be visible because they will be underneath this document window.

#Split Command (Window menu)

Use this command to split the active window into panes.  You may then use the mouse or the keyboard arrows to move the splitter bars.  When you are finished, press the mouse button or enter to leave the splitter bars in their new location.  Pressing escape keeps the splitter bars in their original location.  << In a single document interface application, this command will appear on the View menu. >>

#1, 2, ... command (Window menu)
ModelMagic3D displays a list of currently open document windows at the bottom of the Window menu.  A check mark appears in front of the document name of the active window.  Choose a document from this list to make its window active.  

#Index command (Help menu)

Use this command to display the opening screen of Help.  From the opening screen, you can jump to step-by-step instructions for using ModelMagic3D and various types of reference information.  

Once you open Help, you can click the Contents button whenever you want to return to the opening screen.

#Using Help command (Help menu)

Use this command for instructions about using Help.

#About command (Help menu)

Use this command to display the copyright notice and version number of your copy of ModelMagic3D.

#$Context Help command 




{bml curhelp.bmp}
Use the Context Help command to obtain help on some portion of ModelMagic3D.  When you choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.  Then click somewhere in the ModelMagic3D window, such as another Toolbar button.  The Help topic will be shown for the item you clicked.

Shortcut

Keys:
SHIFT+F1

#Title Bar



{bmc titlebar.bmp} 
The title bar is located along the top of a window.  It contains the name of the application and

document.

To move the window, drag the title bar.  Note: You can also move dialog boxes by dragging their

title bars.

A title bar may contain the following elements:




{bmc bullet.bmp}
Application Control-menu button




{bmc bullet.bmp}
Document Control-menu button




{bmc bullet.bmp}
Maximize button




{bmc bullet.bmp}
Minimize button




{bmc bullet.bmp}
Name of the application




{bmc bullet.bmp}
Name of the document




{bmc bullet.bmp}
Restore button

# Scroll bars
Displayed at the right and bottom edges of the document window.  The scroll boxes inside the scroll bars indicate your vertical and horizontal location in the document.  You can use the mouse to scroll to other parts of the document.

#Size command (System menu)
Use this command to display a four-headed arrow so you can size the active window with the arrow keys.




{bml curarw4.bmp}
After the pointer changes to the four-headed arrow:

1.
Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the border you want to move.  

2.
Press a DIRECTION key to move the border.

3.
Press ENTER when the window is the size you want.

Note:  This command is unavailable if you maximize the window.

Shortcut
Mouse:
Drag the size bars at the corners or edges of the window.

#Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with the arrow keys.




{bmc curarw4.bmp}
Note:  This command is unavailable if you maximize the window.

Shortcut

Keys:
CTRL+F7

#$Minimize command (application Control menu)

Use this command to reduce the ModelMagic3D window to an icon.

Shortcut
Mouse:
Click the minimize icon 


{bmc scmin.bmp} on the title bar.

Keys:
ALT+F9

#Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut
Mouse:
Click the maximize icon 


{bmc scmax.bmp} on the title bar; or double-click the title bar.

Keys:
CTRL+F10 enlarges a document window.

#Next Window command (document Control menu)

Use this command to switch to the next open document window.  ModelMagic3D determines which window is next according to the order in which you opened the windows.

Shortcut

Keys:
CTRL+F6

#Previous Window command (document Control menu)

Use this command to switch to the previous open document window.  ModelMagic3D determines which window is previous according to the order in which you opened the windows.

Shortcut

Keys:
SHIFT+CTRL+F6

#Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.




{bml appexit.bmp}
Note:  If you have multiple windows open for a single document, the Close command on the document Control menu closes only one window at a time.  You can close all windows at once with the Close command on the File menu.

Shortcuts

Keys: 
CTRL+F4 closes a document window


ALT+F4 closes the <<YourType>> window or dialog box

#Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or Minimize command.

#Switch to command (application Control menu)

Use this command to display a list of all open applications.  Use this "Task List" to switch to or close an application on the list.

Shortcut

Keys:
CTRL+ESC

Dialog Box Options

When you choose the Switch To command, you will be presented with a dialog box with the following options:

Task List

Select the application you want to switch to or close.

Switch To

Makes the selected application active.

End Task

Closes the selected application.

Cancel

Closes the Task List box.

Cascade

Arranges open applications so they overlap and you can see each title bar.  This option does not affect applications reduced to icons.

Tile

Arranges open applications into windows that do not overlap.  This option does not affect applications reduced to icons.

Arrange Icons

Arranges the icons of all minimized applications across the bottom of the screen.

#No Help Available
No help is available for this area of the window.
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